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Revision Notes
The following list provides notes concerning revisions of this document.
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2-WIRE LEVEL TRANSMITTER 
PRELEVEL 5343

• Potentiometer or Ohmic input 
• Programmable sensor error value 
• High measurement accuracy 
• Unique process calibration function 
• Programmable via standard PC

Application

•	 Conversion of resistance variation to standard analogue current signals, e.g. 
from Ohmic level sensors or valve positions.

•	 User-defined linearisation function can be activated.

Technical characteristics

•	 Within a few seconds the user can program PR5343 to measure within the 
defined Ohmic values.

•	 Continuous check of vital stored data for safety reasons.

•	 The transmitter is protected against polarity reversal.

•	 PR5343 is configured to the current task by way of a PC, the PRelevel 
software and the communications interface Loop Link.

•	 The PRelevel configuration tool included in the PReset software has been 
developed specifically for the configuration of level applications. Among other 
things, it contains a function for ”on line” measurement of input span as well 
as a linearisation function for volume linear output from horizontal cylindrical 
tanks.

Mounting / installation

•	 For DIN form B sensor head mounting. In non-hazardous areas the 5343 can be 
mounted on a DIN rail with a special fitting.

•	 NB: As Ex barrier for 5343B we recommend 5104B, 5114B or 5116B.
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APPLICATIONS

+
-

+
-

V+

mA

V+

mA

+
-

V+

mA

Ohmic level sensor
to 4...20 mA

2-wire installation
in control room

Potentiometer
to 4...20 mA

Resistance to 4...20 mA

2-wire installation
in control room

2-wire installation
in control room
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Electrical specifications
Specifications range:
-40°C to +85°C
Common specifications:
Supply voltage, DC
	 Standard..................................................................  8.0...35 V 
	 ATEX, FM, IECEx & INMETRO..........................  8.0...30 V 
Internal consumption..............................................  25 mW...0.8 W 
Voltage drop...............................................................  8 VDC 
Warm-up time.............................................................  5 min. 
Communications interface....................................  Loop Link 
Signal / noise ratio...................................................  Min. 60 dB  
Response time (programmable)..........................  0.33...60 s 
Signal dynamics, input............................................  19 bit 
Signal dynamics, output........................................  16 bit 
Calibration temperature.........................................  20...28°C 
Accuracy, the greater of the general and basic values: 

General values

 
Input type

Absolute 
accuracy

Temperature 
coefficient

Lin. R ≤ ±0.1% of span ≤ ±0.01% of span / °C 

EMC immunity influence............................................  < ±0.5% of span

Basic values

 
Input type

Basic 
accuracy

Temperature 
coefficient

Lin. R ≤ ±0.05 Ω ≤ ±0.002 Ω / °C

Order: 5343

Type Version

5343 Standard	 : A 
ATEX, FM, IECEx & INMETRO	 : B 
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Effect of supply voltage change........................  < 0.005% of span / VDC 
Vibration.......................................................................  IEC 60068-2-6 Test FC
	 2...25 Hz..................................................................  ±1.6 mm 
	 25...100 Hz......................................................  ±4 g  
Max. wire size.............................................................  1 x 1.5 mm2 stranded wire 
Humidity.......................................................................  < 95% RH (non cond.) 
Dimensions..................................................................  Ø 44 x 20.2 mm 
Protection degree (enclosure / terminal)........  IP68 / IP00 
Weight...........................................................................  50 g 

Electrical specifications, input:
Linear resistance input:
Measurement range.................................................  0...100 kΩ 
Min. measurement range (span).........................  1 kΩ 
Max. offset..................................................................  50% of selected max. value 
Cable resistance per wire (max.)........................  100 Ω 
Sensor current............................................................  > 25 µA, < 120 µA 
Effect of sensor cable resistance 
(3-wire).........................................................................  < 0.002 Ω / Ω 
Sensor error detection............................................  Yes 

Output:
Current output:
Signal range................................................................  4...20 mA 
Min. signal range.......................................................  16 mA 
Updating time............................................................  135 ms 
Load resistance.........................................................  < (Vsupply - 8) / 0.023 [Ω] 
Load stability..............................................................  < ±0.01% of span/100 Ω

Sensor error detection:
Programmable............................................................  3.5...23 mA 
NAMUR NE43 Upscale............................................  23 mA 
NAMUR NE43 Downscale......................................  3.5 mA 

Of span = Of the presently selected range
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Approvals:
EMC 2004/108/EC...................................................  EN 61326-1
GOST R

Marine approval:
Det Norske Veritas, Ships & Offshore..............  Standard for Certification No. 2.4

Ex:
ATEX 94/9/EC
	 5343A......................................................................  KEMA 10ATEX0004 X
	 5343B......................................................................  KEMA 03ATEX1538 X
FM...................................................................................  2D5A7
IECEx..............................................................................  DEK 13.0036X
INMETRO......................................................................  DEKRA 13.0002 X
GOST Ex
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CONNECTIONS

1 2

mA -+

3 4 63 4 63 4 6

Output:
2-wire installation

Input:
Resistance, 2-wire Resistance, 3-wire

Potentiometer,
3-wire
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BLOCK DIAGRAM
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PROGRAMMING
•	 Loop Link ia a communications interface that is needed for programming 

PRelevel 5343.

•	 For programming please refer to the drawing below and the help function in 
the PRelevel software.

•	 Loop Link is not approved for communication with modules installed in hazard
ous (Ex) areas.

Order: Loop Link

Mechanical specifications	 Mounting of sensor wires

1 

2 

*

*

Loop
Link 5909 - USB

File  Product  Input  Output  Communication  Language  Option  08:30:00

PRetop 5331

Date: 2004-8-10

043201594

PRelectronics

Analog input
Analog output

Serial no:

Input type:
Output type: 4 - 20mA

Upscale
Sensor error:

Pt100  DIN/IEC

0.00 - 50.00 C

3-wire

1.00 sec
------

Input range:

Connection:

Cold junction comp:

Response time:

Tag no:

PRetop 5343

Receiving

EquipmentDisconnect

+Vsupply

Black

Red Yellow

Green

Input

* Connected only for 
‘on-line" programming

Connector

Loop Link

2 0 . 2   m m 

+ - 

+ - 

    

    

  

ø 6 mm

33 mm

ø 44 mm Wires must be mounted between the metal 
plates.
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CONFIGURATION OF POTENTIOMETER INPUT
In an Ohmic level sensor the resistance value changes when a magnetic floater 

activates the reed contacts in the sensor. This means that it is usually not 
possible to make use of the entire level sensor as input span. When PR5343 is 
used with a potentiometer input, the PRelevel software contains the following 
special functions for configuration:

[Calibration Password] is 4711. This password should be entered at program 
start. The only parameters which can be changed without entering this 
password are Input Low and High for the potentiometer input. The menu item 
is located under Tools > Options. Please pay special attention to the text in 
the  ’Information’ window during transmission. When the configuration cannot 
be sent to the transmitter due to lack of password, the following text will 
appear: ’Operation aborted.’ ’Configuration NOT transmitted to the device.’

Figure 1, cross section of horizontal cylindrical tank

0 

10 

20 

30 

40 

50 

60 

70 

80 

90 

100 

0 

10 

20 

30 

40 

50 

60 

70 

80 

90 

100 

In
p

ut
 in

 %
 o

f h
ei

gh
t

% of tank height % of level sensor

E
le

ct
ric

al
 C

al
ib

ra
tio

n

P
la

ce
m

en
t 

C
al

ib
ra

tio
n



	 5343V104-UK	 11

The following description of configuration with potentiometer input is based on 
figure 1. Please note that the PRelevel software only comes in an English-
language version. Therefore the menu texts are represented here as they are 
seen on the screen. First choose the [Input] tab:

[Electrical Calibration] Enter the range to be detected by the connected 
potentiometer or let PRelevel measure the available range. The transmitter 
must be connected to the communications interface before the values can be 
measured. The values in figure 1 are Low = 3% og High = 97%.

[Placement Calibration] Enter the placement of the ’Electrical Calibration’ Low 
and High points of the level sensor in relation to the height of the tank. These 
values are used for calculation of linearisation values and for calculation of 0 
and 100% height. 
The values in figure 1 are Low = 9% and High = 94%.

[Input] Enter the desired input span in relation to the height. When input Low 
and High are selected as 0 and 100%, the input can never go below 9% and 
above 94% due to the design and mounting of the level sensor. If the output 
span is 4...20 mA, the output will only vary between 5.44...19.04 mA. 
The values in figure 1 are Low = 0% and High = 100%.
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ACTIVATION OF EMBEDDED LINEARISATIONS
The PRelevel software contains embedded linearisation functions for horizontal 

cylindrical tanks and spherical tanks. The linearisation functions can be 
activated as follows:

Custom input type: In order to gain access to a customer-defined linearisation, 
the selection in the [General Type] input box must end with the text ’Custom’ 
and the [Calibration Password] 4711 must be entered. 

Activation of linearisation: Choose the [Options] tab in the PRelevel 5343 
window. If one of the embedded linearisations is to be used, the selection in 
the ’Linearisation’ window must be ’Polynomial.....(Relative)’ in order to retrieve 
the most accurate linearisation files. The files are retrieved by way of the 
following menus: >Specify + select >File > Open in the main menu + select 
>File name >Open in the file dialogue box. 

User-defined linearisation: It is possible to enter specific linearisation tables in 
the >Specify menu. 



APPENDIX

ATEX INSTALLATION DRAWING - 5343A

ATEX INSTALLATION DRAWING - 5343B

IECEx INSTALLATION DRAWING - 5343A 

IECEx INSTALLATION DRAWING - 5343B

FM INSTALLATION DRAWING - 5343B

INMETRO INSTRUÇÕES DE SEGURANÇA - 5343A

INMETRO INSTRUÇÕES DE SEGURANÇA - 5343B
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ATEX Installation drawing 
 
For safe installation of 5343A the following must be observed. The module shall only be installed 
by qualified personnel who are familiar with the national and international laws, directives and 
standards that apply to this area.  
Year of manufacture can be taken from the first two digits in the serial number. 

 
 
 

ATEX Certificate        KEMA 10ATEX 0004X 
 
Marking 

 
 
 
    

 
  
 Standards EN 60079-0 : 2012, EN 60079-11 : 2012, EN 60079-15 : 2010 
    
     

 
 
 
 
 
 
 
 
 
 
 
 

 
            Special conditions for safe use 

 
 
For type of protection Ex nA, the transmitter shall be mounted in a metal enclosure providing a 
degree of protection of at least IP54 according to EN60529. 
 
For use in the presence of combustible dusts the transmitter shall be mounted in an enclosure  
providing a degree of protection of at least IP6X in accordance with EN60529, the surface 
temperature of the outer enclosure is 20 K above the ambient temperature 
 
For an ambient temperature ≥ 60ºC, heat resistant cables shall be used with a rating of at least 
20 K above the ambient temperature. 
 
 

T4:  -40 ≤ Ta ≤ 85ºC   
T6:  -40 ≤ Ta ≤ 60ºC   

II 3 G Ex nA [ic] IIC T4 … T6 Gc 
II 3 G Ex ic IIC T4…T6 Gc 
II 3 D Ex ic IIIC Dc 

Terminal: 3,4,6 
Ex nA [ic] 
 
Uo:  5V 
Io:   4 mA 
Po:  20 mW 
Lo:  900 mH 
Co:  1000 μF 

Terminal: 1,2 
Ex nA 
 
Umax.  ≤ 35 VDC 

Terminal: 1,2 
Ex ic 
 
Ui = 35 VDC 
Ii = 110 mA 
Li  = 10 μH 
Ci = 1.0 nF 
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ATEX Installation drawing 
  
For safe installation of 5343B the following must be observed. The module shall only be Installed by 
qualified personnel who are familiar with the national and international laws, directives and 
standards that apply to this area.  
Year of manufacture can be taken from the first two digits in the serial number. 

 
 
 

ATEX Certificate        KEMA 03ATEX 1538 X 
 
Marking 

 
 
    

 
 Standards EN 60079-0 : 2012, EN 60079-11 : 2012, EN 60079-26 : 2007  
        

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 

 

Non Hazardous Area 
Hazardous area 
Zone 0, 1, 2, 20, 21, 22 

 
 

II 1 G Ex ia IIC T4...T6 Ga  
II 1 D Ex ia IIIC Da 
II 1 M Ex ia I Ma 

Terminal: 3,4,6 
Uo: 30 VDC 
Io:   8 mA 
Po:  60 mW 
Lo:  35 mH 
Co: 66 nF 

Terminal: 1,2 
Ui: 30 VDC 
Ii:   120 mA 
Pi:  0.84 W 
Li:  10μH 
Ci:  1.0nF 

1

2

6

5

4

3

+

-

Barrier

5343B

T4:  -40 ≤ Ta ≤ 85ºC 
T6:  -40 ≤ Ta ≤ 60ºC  
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Installation notes. 
 
In a potentially explosive gas atmosphere, the transmitter shall be mounted in an enclosure in 
order to provide a degree of protection of at least IP20 according to EN60529. 
 
If the transmitter is installed in an explosive atmosphere requiring the use of equipment of 
category 1 G, 1 M or 2 M, and if the enclosure is made of aluminum, if must be installed such, 
that ignition sources due to impact and friction sparks are excluded. 
 
If the enclosure is made of non-metallic materials, electrostatic charging shall be avoided. 
 
For installation in a potentially explosive dust atmosphere, the following instructions apply: 
 
The transmitter shall be mounted in a metal enclosure form B according to DIN43729 that is 
providing a degree of protection of at least IP6X according to EN60529, that is suitable for the 
application and correctly installed. 
 
Cable entries and blanking elements shall be used that are suitable for the application and 
correctly installed. 
 
For an ambient temperature ≥ 60ºC, heat resistant cables shall be used with a rating of at least 
20 K above the ambient temperature. 
 
 
The surface temperature of the enclosure is equal to the ambient temperature plus 20 K, for a 
dust layer with a thickness up to 5 mm 
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IECEx Installation drawing 
    
For safe installation of 5333A or 5343A the following must be observed. The module shall only be 
installed by qualified personnel who are familiar with the national and international laws, 
directives and standards that apply to this area.  
Year of manufacture can be taken from the first two digits in the serial number. 

 
 

Certificate                 IECEx  DEK 13.0036X 
 
Marking 

 
 
 
    

 Standards IEC 60079-0 : 2011, IEC 60079-11 : 2011, IEC 60079-15 : 2010 
    
  
 
 

Terminal Ex nA [ic] Ex ic 

1,2 Umax = 35V Ui : 35V,    Ii:110mA,    Ii:10µH,    Ci:1,0nF 

3,4,6 Uo: 5V,   Io: 4mA,   Po: 20mW,   Lo: 900mH,     Co: 1000µF 

 
 

 
      Installation note: 

 
 For installation in a potentialy explosive gas atmosphere, the following instructions apply: 

 
For nA installation the transmitter must be installed in an metal enclosure e.g. a form B 
enclosure, providing a degree of protection of at least IP54 according to IEC60529 or in an 
enclosure with type of protection Ex n or Ex e. 
 
For ic installation the transmitter must be installed in enclosure providing a degree of 
protection of at least IP20 according to IEC60529 and that is suitable for the application. 
 
Cable entry devices and blanking elements shall fulfill the same requirements 
 
 
For an ambient temperature ≥ 60ºC, heat resistant cables shall be used with a rating of at 
least 20 K above the ambient temperature. 

 
 

For installation in a potentially explosive dust atmposphere, the following instructions apply: 
The surface temperature of the enclosure is equal to the ambient temperature plus 20 K, for a 
dust layer with a thickness up to 5 mm. 
The transmitter must be mounted in a enclosure according to DIN 43729 that provides a 
degree of protection of at least IP6X according to IEC60529, and that is suitable for the 
application. Cable entry devices and blanking elements shall fulfill the same requirements.  
 

 

T4:  -40 ≤ Ta ≤ 85ºC   
T6:  -40 ≤ Ta ≤ 60ºC   

Ex nA [ic] IIC T6..T4 Gc 
Ex ic IIC T6..T4 Gc 
Ex ic IIIC Dc 
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IECEx Installation drawing 
  
For safe installation of 5333D or 5343B the following must be observed. The module shall only be 
installed by qualified personnel who are familiar with the national and international laws, directives 
and standards that apply to this area.  
Year of manufacture can be taken from the first two digits in the serial number. 

 
 
 

Certificate                 IECEx DEK 13.0036X 
 
Marking 

 
 
    

 
 Standards IEC 60079-0 : 2011, IEC 60079-11 : 2011, IEC 60079-26:2006 
    

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Non Hazardous Area 
Hazardous area 
Zone 0, 1, 2, 20, 21, 22, M1 

Ex ia IIC T4…T6 Ga 
Ex ia IIIC Da 
Ex ia I Ma 

1

2

6

5

4

3

+

-

Barrier

5333D
5343B

Terminal: 1,2 
Ui: 30 VDC 
Ii:   120 mA 
Pi:  0.84 W 
Li:  10μH 
Ci:  1.0nF 

T4:  -40 ≤ Ta ≤ 85ºC  
T5:  -40 ≤ Ta ≤ 60ºC  
T6:  -40 ≤ Ta ≤ 45ºC  

Terminal: 3,4,6 
Uo: 30 VDC 
Io:   8 mA 
Po:  60 mW 
Lo:  35 mH 
Co:  66 nF 
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Installation notes. 
 

 
In a potentially explosive gas atmosphere, the transmitter shall be mounted in a metal form B 
enclosure in order to provide a degree of protection of at least IP20 according to IEC60529. If 
however the environment requires a higher degree of protection, this shall be taken into 
account. 
 
If the transmitter is installed in an explosive atmosphere requiring the use of equipment 
protection level Ga, Ma and Mb, and if the enclosure is made of aluminum, it must be installed 
such, that ignition sources due to impact and friction sparks are excluded. 
 
 
For installation in a potentially explosive dust atmosphere, the following instructions apply: 
 
For explosive dust atmospheres, the surface temperature of the outer enclosure is 20 K above 
the ambient temperature. 
 
The transmitter shall be mounted in a metal enclosure form B according to DIN43729 that is 
providing a degree of protection of at least IP6X according to IEC60529, that is suitable for the 
application and correctly installed. 
 
Cable entries and blanking elements shall be used that are suitable for the application and 
correctly installed. 
 
For an ambient temperature ≥ 60ºC, heat resistant cables shall be used with a rating of at least 
20 K above the ambient temperature. 

 
 
 
 

 
. 
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FM Installation Drawing 5300Q502 Rev AH 
 

Model 5331C,5331D, 5333C, 5333D and 5343B 

 

 

 

 

 

 

Model 5335C, 5335D, 5336D, 5337D 

 

 

 

 

 

Non Hazardous LocationHazardous (Classified) Location

Associated Apparatus
or Barrier  

with 
entity Parameters:

SENSOR

1 2

3

45

6

UM < 250V
Voc or Uo  < Vmax or Ui
Isc or Io   <   Imax or Ii
Po  <  Pi
Ca or Co > Ci + Ccable
La or Lo  > Li + Lcable

This device must not be connected 
to any associated apparatus which 
uses or generates more than 250 
VRMS

+

‐
Terminal 1 , 2
Vmax or Ui: 30 V
Imax or Ii: 120 mA
Pmax or Pi: 0.84 W
Ci: 1 nF
Li:10 uH

Terminal 3,4,5,6
Only passive, or non-energy 
storing devices such as RTD's 
and Thermocouples may be 
connected.

Ambient temperature limits
T4: ‐40 to + 85 deg. Celcius
T6: ‐40 to + 60 deg. Celcius

Class I,Division1, Groups, A,B,C,D
Class I, Zone 0, IIC

Non Hazardous LocationHazardous (Classified) Location

Associated Apparatus
or Barrier  

with 
entity Parameters:

SENSOR

1 2

3

45

6

UM < 250V
Voc or Uo  < Vmax or Ui
Isc or Io   <   Imax or Ii
Po  <  Pi
Ca or Co > Ci + Ccable
La or Lo  > Li + Lcable

This device must not be connected 
to any associated apparatus which 
uses or generates more than 250 
VRMS

+

‐
Terminal 1 , 2
Vmax or Ui: 30 V
Imax or Ii: 120 mA
Pmax or Pi: 0.84 W
Ci: 1 nF
Li:10 uH

Terminal 3,4,5,6
Vt or Uo: 9.6 V
It or Io: 28 mA
Pt or Po: 67.2 mW
Ca or Co: 3.5 uF
La or Lo: 35 mH

Ambient temperature limits
T4: ‐40 to + 85 deg. Celcius
T6: ‐40 to + 60 deg. Celcius

Class I,Division1, Groups, A,B,C,D
Class I, Zone 0, IIC

1/2
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 The entity concept 
The Transmitter must be installed according to National Electrical Code (ANSI-NFPA 70) and shall be 
installed with the enclosure, mounting, and spacing segregation requirement of the ultimate application.  
 

Equipment that is FM-approved for intrinsic safety may be connected to barriers based on the ENTITY 
CONCEPT. This concept permits interconnection of approved transmitters, meters and other devices in 
combinations which have not been specifically examined by FM, provided that the agency's criteria are 
met. The combination is then intrinsically safe, if the entity concept is acceptable to the authority having 
jurisdiction over the installation. 

The entity concept criteria are as follows: 

      The intrinsically safe devices, other than barriers, must not be a source of power. 
The maximum voltage Ui(VMAX) and current Ii(IMAX), and maximum power Pi(Pmax), which the device can 
receive and remain intrinsically safe, must be equal to or greater than the voltage (Uo or VOC or Vt) and 
current (Io or ISC or It) and the power Po which can be delivered by the barrier. 
 
The sum of the maximum unprotected capacitance (Ci) for each intrinsically device and the interconnect-
ing wiring must be less than the capacitance (Ca) which can be safely connected to the barrier. 
 
The sum of the maximum unprotected inductance (Li) for each intrinsically device and the interconnecting 
wiring must be less than the inductance (La) which can be safely connected to the barrier. 
 
The entity parameters Uo,VOC or Vt and Io,ISC or It, and Ca and La for barriers are provided by the barrier 
manufacturer. 
 
NI Field Circuit Parameters 
 
Model 5331C, 5331D, 5333C, 5333D, 5335C, 5335D, 5336D, 5337D and 
5343B 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Non Hazardous LocationHazardous (Classified) Location

Associated Apparatus
or Barrier  

SENSOR

1 2

3

45

6 This device must not be connected 
to any associated apparatus which 
uses or generates more than 250 
VRMS

+

‐

Terminal 1 , 2
Vmax : 35 V
Ci: 0 µ F
Li:10 uH

Ambient temperature limits
T4: ‐40 to + 85 deg. Celcius
T6: ‐40 to + 60 deg. Celcius

Class I,Division2, Groups, A,B,C,D
Class I, Zone 2, IIC

2/2
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Desenho de Instalação InNMETRO 
 
Para instalação segura do 5333A ou 5343A o seguinte deve ser observado. O modo deve 
apenas ser instalado por pessoas qualificadas que são familiarizadas com as leis nacionais e 
internacionais, diretrizes e padrões que se aplicam a esta área.  
Ano de fabricação pode ser pego dos dois primeiros dígitos do número de série. 

 
 

Certificado                 IECEx  DEK 13.0002 X 
 
Indicaçã 

 
 
 
    

 Padrões ABNT NBR IEC 60079-0 : 2008, ABNT NBR IEC 60079-11 : 2009, 
  IEC 60079-15 : 2010, ABNT NBR IEC 60079-26 : 2008 
    
  
 
 

Terminal Ex nA [ic] Ex ic 

1,2 Umax = 35V Ui : 35V,    Ii:110mA,    Ii:10µH,    Ci:1,0nF 

3,4,6 Uo: 5V,   Io: 4mA,   Po: 20mW,   Lo: 900mH,     Co: 1000µF 

 
 

  
Notas para instalação 
 
Para a instalação em uma atmosfera de gás potencialmente explosivo, se aplicam as instruções a 
seguir: 

Para a instalação nA o transmissor deve ser instalado em um gabinete de metal, por exemplo, 
gabinete em forma B que forneça um grau de proteção de pelo menos IP54 de acordo com 
IEC60529 ou em um caixa com tipo de proteção Ex n ou Ex e. 
Para a instalação iC o transmissor deve ser instalado em um invólucro proporcionando um grau 
de proteção de IP20, pelo menos, de acordo com a norma IEC60529 que é adequado para a 
aplicação. 
Dispositivos de entrada de cabos e elementos de supressão devem cumprir os mesmos 
requisitos. 
Para uma temperatura ambiente ≥ 60 º C, os cabos resistentes ao calor precisam ser utilizados 
com uma classificação de pelo menos 20 K acima da temperatura ambiente. 

 
Para a instalação em uma atmosfera de poeira potencialmente explosiva , se aplicam as instruções a 
seguir:  

A temperatura da superfície do invólucro é igual à temperatura ambiente mais 20 K, para uma 
camada de pó , com uma espessura superior a 5 mm. 
O transmissor deve ser montado em um invólucro de acordo com a norma DIN 43729 , que 
proporciona um grau de proteção de, pelo menos, IP6X de acordo com a norma IEC60529, e 
que seja apropriado para a aplicação. 
Dispositivos de entrada de cabos e elementos de supressão devem cumprir as mesmas 
exigências 

T4:  -40 ≤ Ta ≤ 85ºC   
T6:  -40 ≤ Ta ≤ 60ºC   

Ex nA [ic] IIC T6..T4 Gc 
Ex ic IIC T6..T4 Gc 
Ex ic IIIC Dc 
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Desenho de Instalação InNMETRO 
  
Para instalação segura do 5333D ou 5343B o seguinte deve ser observado. O modo deve apenas 
ser instalado por pessoas qualificadas que são familiarizadas com as leis nacionais e 
internacionais, diretrizes e padrões que se aplicam a esta área.  
Ano de fabricação pode ser pego dos dois primeiros dígitos do número de série. 

 
 
 

Certificado DEKRA 13.0002 X 
 
Indicação 
 
 
 
 
Padrões ABNT NBR IEC 60079-0 : 2008, ABNT NBR IEC 60079-11 : 2009, 
 IEC 60079-15 : 2010, ABNT NBR IEC 60079-26 : 2008 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 

Sem áreas perigosas 
Áreas perigosas 
Zona 0, 1, 2, 20, 21, 22, M1 

Ex ia IIC T6…T4 Ga 
Ex ia IIIC Da 
 

1

2

6

5

4

3

+

-

Barrier

5333D
5343B

Terminal: 1,2 
Ui: 30 VDC 
Ii:   120 mA 
Pi:  0,84 W 
Li:  10 μH 
Ci:  1,0 nF 

T4:  -40 ≤ Ta ≤ 85ºC  
T5:  -40 ≤ Ta ≤ 60ºC  
T6:  -40 ≤ Ta ≤ 45ºC  

Terminal: 3,4,5,6 
Uo: 30 VDC 
Io:   8 mA 
Po:  60 mW 
Lo:  35 mH 
Co:  66 nF 
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Notas de Instalação. 

 
Em uma atmosfera de gás potencialmente explosiva, o transmissor deve ser montado em um 
enclousure a fim de garantir um grau de proteção de no mínimo IP20 de acordo com 
EN60529. Se contudo o ambiente requer um nível de proteção maior, isso deve ser levado em 
conta 
 
Se o transmissor é instalado em uma atmosfera explosiva exigindo o uso de equipamento de 
categoria Ga e se o enclosure é feito de alumínio, ele deve ser instalado de modo que, mesmo 
em caso de avaria rara, fontes de ignição devido a impacto e fricção, faíscas são eliminadas; 
se o enclosure é feito de materiais não metálicos, cargas eletroestáticas devem ser evitadas. 
  
 
Para instalação em atmosfera de poeira potencialmente explosiva, as instruções a seguir: 
 
O transmissor deve ser montado em enclosure de metal forma B de acordo com DIN43729 
que está fornecendo um grau de proteção de pelo menos IP6X de acordo com EN60529. Isso 
é adequado para aplicação e corretamente instalado. 
 
As entradas dos cabos e os elementos de obturação que podem ser utilizados são adequados 
para a aplicação e corretamente instalados. 
 
Para temperatura ambiente >= 60ºC, fios de resistência ao calor devem ser usados com uma 
faixa de pelo menos 20K acima da temperatura ambiente. 

 
 
A temperatura da superfície do enclosure é igual à temperatura ambiente mais de 20 K, por 
uma camada de pó, com uma espessura até 5 mm. 
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Programmable displays with a wide 
selection of inputs and outputs for display of temperature, 
volume and weight, etc. Feature linearization, scaling, and 
difference measurement functions for programming via 
PReset software.

Displays

A wide selection of transmitters for DIN 
form B mounting and DIN rail devices with analog and 
digital bus communication ranging from application-
specific to universal transmitters.

Temperature

Galvanic isolators for analog and digital 
signals as well as HART® signals. A wide product range 
with both loop-powered and universal isolators featuring 
linearization, inversion, and scaling of output signals.

Isolation

Interfaces for analog and digital signals as 
well as HART® signals between sensors / I/P converters / 
frequency signals and control systems in Ex zone 0, 1 & 2 
and for some devices in zone 20, 21 & 22.

Ex interfaces

PC or front programmable devices with 
universal options for input, output and supply. This range 
offers a number of advanced features such as process 
calibration, linearization and auto-diagnosis.

Universal
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